### Altair Engineering Contact Information

**Web site**  
www.altair.com

**FTP site**  
Login: ftp  
Password: <your e-mail address>

<table>
<thead>
<tr>
<th>Location</th>
<th>Telephone</th>
<th>e-mail</th>
</tr>
</thead>
<tbody>
<tr>
<td>North America</td>
<td>248.614.2425</td>
<td><a href="mailto:hwsupport@altair.com">hwsupport@altair.com</a></td>
</tr>
<tr>
<td>China</td>
<td>86.21.5393.0011</td>
<td><a href="mailto:support@altair.com.cn">support@altair.com.cn</a></td>
</tr>
<tr>
<td>France</td>
<td>33.1.4133.0990</td>
<td><a href="mailto:francesupport@altair.com">francesupport@altair.com</a></td>
</tr>
<tr>
<td>Germany</td>
<td>49.7031.6208.22</td>
<td><a href="mailto:hwsupport@altair.de">hwsupport@altair.de</a></td>
</tr>
<tr>
<td>India</td>
<td>91.80.6629.4500</td>
<td><a href="mailto:support@india.altair.com">support@india.altair.com</a></td>
</tr>
<tr>
<td></td>
<td>1.800.425.0234 (toll free)</td>
<td></td>
</tr>
<tr>
<td>Italy</td>
<td>39.800.905.595</td>
<td><a href="mailto:support@altairtorino.it">support@altairtorino.it</a></td>
</tr>
<tr>
<td>Japan</td>
<td>81.3.5396.1341</td>
<td><a href="mailto:support@altairjp.co.jp">support@altairjp.co.jp</a></td>
</tr>
<tr>
<td></td>
<td>81.3.5396.2881</td>
<td></td>
</tr>
<tr>
<td>Korea</td>
<td>82.31.716.4321</td>
<td><a href="mailto:support@altair.co.kr">support@altair.co.kr</a></td>
</tr>
<tr>
<td>Scandinavia</td>
<td>46.46.286.2052</td>
<td><a href="mailto:support@altair.se">support@altair.se</a></td>
</tr>
<tr>
<td>United Kingdom</td>
<td>44.1926.468.600</td>
<td><a href="mailto:support@uk.altair.com">support@uk.altair.com</a></td>
</tr>
<tr>
<td>Brazil</td>
<td>55.11.4223.5733</td>
<td><a href="mailto:br_support@altair.com">br_support@altair.com</a></td>
</tr>
<tr>
<td>Australia</td>
<td>64.9.413.7981</td>
<td><a href="mailto:anzsupport@altair.com">anzsupport@altair.com</a></td>
</tr>
<tr>
<td>New Zealand</td>
<td>64.9.413.7981</td>
<td><a href="mailto:anzsupport@altair.com">anzsupport@altair.com</a></td>
</tr>
</tbody>
</table>

The following countries have distributors for Altair Engineering: Mexico, Romania, Russia, South Korea, Singapore, Spain, Taiwan and Turkey. See www.altair.com for complete contact information.

© 2007 Altair Engineering, Inc. All rights reserved. No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated to another language without the written permission of Altair Engineering, Inc. To obtain this permission, write to the attention Altair Engineering legal department at: 1820 E. Big Beaver, Troy, Michigan, USA, or call +1-248-614-2400.

### Trademark and Registered Trademark Acknowledgments

Listed below are Altair® HyperWorks® applications. Copyright® Altair Engineering Inc., All Rights Reserved for:


All other trademarks and registered trademarks are the property of their respective owners.
HyperMesh 8.0 Tutorials
Geometry

Importing and Repairing CAD - HM-2000................................................................. 1
Generating a Midsurface - HM-2010 ....................................................................... 11
Simplifying Geometry - HM-2020 .......................................................................... 25
Refining Topology to Achieve a Quality Mesh - HM-2030................................. 33
Creating and Editing Line Data - HM-2040 ............................................................ 45
Creating Surfaces from Elements - HM-2050 ......................................................... 59
Creating and Editing Solid Geometry - HM-2060................................................... 70
Importing and Repairing CAD - HM-2000

In this tutorial, you will:

- Delete untrimmed surfaces
- Close missing surfaces
- Set the cleanup tolerance
- Equivalence free edges
- Delete duplicate surfaces

The benefits of importing and repairing CAD are:

- Correct any errors in the geometry from import
- Create the simplified part needed for the analysis
- Mesh a part all at once
- Ensure proper connectivity of mesh
- Obtain a desirable mesh pattern & quality

HyperMesh Terminology

This image identifies various geometric figures found on models labeled with the terminology used in HyperMesh for faces, edges, and points. Refer to the definitions below for each feature identified on this image.
The autocleanup panel will be used in this tutorial and can be accessed by one of two methods:

- On the Geometry menu, click Auto Cleanup
- On the Geom page, click the autocleanup panel

The autocleanup panel performs automatic geometry cleanup and prepares it for meshing based on the parameters set in the panel. Cleanup operations include the equivalencing of “red” free edges, fixing of small surfaces (relative to the element size), and detection of features such as beads. It also performs specified surface editing/defeaturing operations like removal of pinholes (less than specified size), removal of edge fillets, and the addition of a layer of washer elements around holes.

The quick edit panel will be used in this tutorial and can be accessed by one of two methods:

- Press F11
- On the Geometry menu, click Quick Edit

The quick edit panel allows you to split surfaces and washers, change the category (shared, free, etc.) of edges, create or delete surfaces and points, project points, and trim fillets.
The **surfaces** panel will be used in this tutorial and can be accessed by one of two methods:

- On the **Geometry** menu, point to **Surfaces**, click **Create**
- On the **Geom** page, click the **surfaces** panel

The **surfaces** panel allows you to create new surfaces using a variety of techniques.

---

**Exercise: Importing and Repairing CAD Geometry Data**

This exercise uses the model file, *clip_repair.hm*.

![Model Image](image)

**Step 1: Retrieve and view the model file.**

The model for this exercise is *clip_repair.hm*. Take a few moments to observe the model using the different visual options available in HyperMesh (rotation, zooming, etc.).
Step 2: View the model in topology display and shaded mode to evaluate its integrity.

1. Observe where the model has incorrect connectivity and missing or duplicate surfaces.
2. Go to the autocleanup panel.
   
   Note that the surface edges are now colored according to their topology status. This occurs because the Geometry Color option, is set to auto.

3. Click the Wireframe Geometry and Shaded Geometry & Surface Edges icons to explore the different display modes.
   
   The toolbar contains icons that control the display of the surfaces and surface edges. Surfaces can be shaded with or without edges, or wireframe. Right-click the icons to access the drop down menu for additional options. Place your mouse over the cursor to view a description of the button’s functionality.

4. Click the Visualization icon and Topology tab.
   
   Visualization controls the display of the surfaces and surface edges. Surfaces can be shaded or wireframe. The check boxes within this menu turn the display of the different edge types and fixed points (surface vertices) on or off.

5. Clear all the check boxes except the Free check box.

6. Move the mouse cursor off the pop-up menu to close it.
   
   Only the free edges should be displayed at this point.

7. Observe the free edges and make a mental note of where they are.
   
   The free (red) edges show where there is incorrect connectivity or gaps.

8. Note the locations where there are closed loops of free edges. These are locations that probably have missing surfaces.
Free edges indicating surface discontinuities of the clip geometry

9. Click the **Visualization** icon, and select only the **T-junctions edges** check box.

10. Observe the t-junction edges and make a mental note of where they are.

   The t-junction edges show where there are more than two surfaces sharing an edge, which might be incorrect connectivity. For this part, there yellow edges completely surrounding two areas. This tells us there are probably duplicate surfaces in these locations.

11. Click the **Visualization** icon, and select all the check boxes.

12. Click the **Shaded Geometry & Surface Edges** icon.

   The surfaces should now appear solid rather than having only their edges displayed.

13. Rotate, zoom, and pan to locate any errors in the geometry.
14. Make a mental note of the areas to be worked on. We find:

- A surface that overhangs a round corner
- A missing surface

15. Click the **Wireframe Geometry** to change back to wireframe.
Step 3: Delete the surface that overhangs the round corner.
1. Go to the quick edit panel.
2. Beside the delete surf: menu select surf.
3. Select the overhanging surface shown in the previous figure.
4. Click return.

Step 4: Create surfaces to fill large gaps in the model.
1. Go to the surfaces panel.
2. Go to the spline/filler sub-panel.
3. Clear the keep tangency check box.
   The keep tangency option looks at surfaces attached to the selected edges and tries to create a surface tangent to them. This helps to form a smooth transition to the surrounding surfaces.
4. Ensure the entity type is set to lines.
5. Ensure the auto create (free edges) check box is selected.
   The auto create option simplifies the selection of the lines bounding the missing surface. Once a line is selected, HyperMesh automatically selects the remaining free edges that form a closed loop, and then create the filler surface.
6. Zoom into the area indicated in the following image.
7. Pick one of the red lines bounding one of the holes. HyperMesh automatically creates a filler surface to close the hole.
8. Repeat #7 to create a filler surface in the other gap.
9. Click return.

**Step 5: Release the fixed points in the area of the collapsed edge.**

1. On the Geometry menu, point to Edit, and click Point.
2. Go to the release sub-panel.
3. Rotate and zoom in on the area of the collapsed edge.
4. Select the point indicated in the image below to release the fixed point.
5. Two fixed points will separate, and the edges connected to them will all become free edges.

![Fixed point to be released](image)

6. Click return to go to the main menu.

**Step 6: Set the global geometry cleanup tolerance to .01.**

1. Press O to go to the options panel.
2. Go to the modeling sub-panel.
3. In the cleanup tol = field, type .01 to stitch the surfaces with a gap less than 0.01.
4. Click return to go to the main menu.
Step 7: Combine multiple free edge pairs at one time with the equivalence tool.

1. On the Geometry menu, point to Edit, and click Edge.
2. Go to the equivalence sub-panel.
3. Check the equiv free edges only check box.
4. Select surfs >> all.
5. Verify that the cleanup tol= is set to 0.01, which is the global cleanup tolerance specified in the options panel.
6. Click the green equivalence button to combine any free edge pairs within the specified cleanup tolerance.

Most of the red free edges are combined into green shared edges. The few remaining are caused by gaps larger than the cleanup tolerance.

Step 8: Combine free edge pairs, one pair at a time, using the toggle.

1. Go to the toggle sub-panel.
2. In the cleanup tol = field, type 0.1.
3. In the graphics area, click on one of the free edges shown in the image below.
4. Rotate and zoom into the area if needed. When the edge is selected, it will change from red to green, indicating that the free edge pair has been equivalenced.

Area where free edges need to be toggled

5. Use toggle to equivalence the other edges shown in the image.
Step 9: Combine the remaining free edge pair using replace.

1. Go to the replace sub-panel.
2. Click the user views icon.
3. Click restore1 to bring back the saved view.
4. With the selector under retained edge: active, click on the rightmost free edge. The selector under moved edge becomes active automatically.
5. Select the leftmost red edge.
6. Click replace.

Once the line is selected, HyperMesh posts a message similar to:

Gap = (.20000). Do you still wish to toggle?

7. Click Yes to close the gap.

8. Click return to go to the main menu.

Step 10: Find and delete all duplicate surfaces.

You should still be in the geom cleanup panel.

1. On the Geometry menu, click Defeature.
2. Go to the duplicates sub-panel.
3. Select surfaces >> displayed.
4. In the cleanup tol = field, type 0.01.
5. Click find.

The header bar displays the following message, "2 surfaces are duplicated".
6. Click delete to remove any duplicate surfaces.

Step 11: Observe the model again to identify any remaining free edges, or missing or duplicate surfaces.

Use the topology display and shaded modes to perform this task. All of the edges in the model should be displayed as green shared edges, indicating that we have a completely enclosed thin solid part.

- Click return to go to the main menu.

Step 12 (Optional): Save your work

With the cleanup operations completed, save the model.
Generating a Midsurface - HM-2010

In this tutorial you will learn how to:

- Obtain the midsurface of two given surfaces
- Extract the midsurface of a more complicated group of surfaces that represent an electrical housing solid bracket.

A midsurface is the midplane layer of geometry that when meshed, can be used as a finite element shell representation of a given solid part. Midsurface extraction can be used with sheet metal stampings, molded plastic parts with ribs, and other parts consisting of plates; for example, pieces with a thickness clearly smaller than the width and length.

Tools

The **midsurface** feature can be accessed by:

- On the **Geom** page, click the **midsurface** panel
- On the **Geometry** menu, click **Midsurface**

The **midsurface** panel allows you to extract the midsurface representation of a solid part. It can be used to generate a finite element shell representation of a solid geometry. It can also be used with sheet metal stampings, molded plastic parts with ribs, and other parts that have thickness clearly smaller than width and length.
Exercise 1: Generating a Midplane from Solid Geometry

This exercise uses the model file, electrical_housing.hm. The model geometry is an electrical housing bracket.

Step 1: Load and review the model.

1. From the files panel select the hm file sub-panel and retrieve the file <install_directory>/tutorials/hm/electrical_housing.hm.
   The model is organized into two HyperMesh component collectors: one corresponds to the original IGES layer lvl0 and the other is called Broken Middle Surface.

2. Click the Shaded Geometry and Surface Edges icon.

3. To turn off surface transparency, go to the View pull-down menu > Display > Transparency and click the reset button next to comps.

4. Observe the model using the HyperMesh view controls.
   When you want to midsurface a part, it is important to have a clear understanding of the geometry of the part itself. This helps you determine whether or not the midsurfaces obtained are consistent with the original geometry.

   Note  The original geometry that you select to extract midsurfaces remains unchanged. The variable thickness for each midsurface is calculated and stored in the database.
Step 2: Obtain baseline midsurfaces.

1. Extract midsurfaces for the entire bracket.
   - From the Geom page select the midsurface panel.
   - Select the create sub-panel.
   - Select the solid function.
   The solid function allows you to extract midsurfaces of entire parts at once. The between surfs function works on one pair of surfaces at a time.
   - Ensure that the Broken Middle Surface is turned off.
   - Verify the toggle is set to closed solid.
   - Click surfs and select displayed.
   - Click extract.
   HyperMesh extracts the midsurfaces and places them into the Middle Surface component collector. This new component becomes the current component, as shown in the header bar. For more detailed descriptions on the various options available in the advanced options mode, click the HyperMesh help button to bring up the context sensitive help for this panel.

2. Change the level of transparency of the surfaces in the lvl0 component.
   - On the View menu, point to Display, and click Transparency.
   - Use the slider bar to vary the level of transparency between 0 and 10.
   - Click comps to review and modify the list of components to which transparency is applied.
   - Set the transparency level to 5 and go back to the midsurface panel.
   The surfaces in the lvl0 components are now transparent and only their edges are visible.
   Note By default, all the components, except the one in which the midsurfaces are placed, are automatically selected for transparency settings in this panel, and their level of transparency can be adjusted from opaque to fully transparent.

3. Notice that a complete midsurface has been created successfully. Check the model in more depth.
   Note You will check and fix the problem areas with a pre-existing midsurface.

4. Turn off Middle Surface, and turn on Broken Middle Surface.

5. On the toolbar, click the User Views icon and restore pre-defined view1.
   Notice how a midsurface is missing in this area.

Notice how some of the midsurfaces created here do not match up.

Three of the main types of problems that can appear with generated midsurfaces are:
- The midsurface is incorrectly shaped.
- The midsurface is correctly shaped, but incorrectly positioned.
- The midsurface is incorrectly shaped and incorrectly positioned.

Most of the problem midsurfaces shown in the image above fall into these categories of problems. Some specific examples of these will be covered in the next section.

Various tools and techniques can be used to correct these problems, and will typically produce the same sought result: correctly shaped and positioned midsurfaces. Some of these techniques are presented in the next sections as we take a closer look at the problems in our example model. The techniques presented involve tools available on the midsurface panel itself.

In this section, you used the midsurface panel to generate midsurfaces for an entire part in a single step. You then used the transparency tool to identify areas where various problems in a pre-existing midsurface, such as missing or incorrect surfaces, may be present.
Step 3: Create or re-create individual midsurfaces.

1. Restore view3.

   [Image]

   Incorrectly positioned surface

   Notice how this surface is incorrectly positioned in the sense that it does not follow the midplane of the section it represents.

2. Restore view4.

   [Image]

   Incorrectly shaped surface

   Notice how this same surface is also incorrectly shaped in the sense that one corner does not line up the two corners of which it is a mid-representation, and also in the sense that one of the edges is not straight.

   One possible approach for resolving these issues is to simply delete the faulty midsurface and re-generate one there manually. Before proceeding, it is important to have a clear understanding of the geometry at hand as well as the behavior and requirements of the \textit{between surf} option.
3. From the **midsurface** panel select the **create** sub-panel, and select the **between surfis** function. This function generates a midplane surface between two surfaces selected as **side1** and **side2**. This means that a midplane cannot be created, for example, between one surface on one side and two surfaces on the corresponding opposite side. To check for any such situation in our model, set the transparency of all surfaces back to opaque (0).

4. Set the transparency to 0.

Observe the surfaces in the **lvl0** component and look for sections where opposite sides are defined with a dissimilar number of surfaces.

The two images below show one example:

For example, for this particular case, you would need to first suppress the shared (green) edge between the two surfaces so that only one surface is left for selection as **side1** or **side2**. With our model, we will arbitrarily pick some of the bad midsurfaces, delete them and re-generate them.
5. Set the transparency back to 10.

6. From the Tool page select the delete panel to delete the 3 midsurfaces identified in the image below.

![Image](image1.png)

Delete these 3 surfaces

For the remainder of this section, you can work either with shaded surfaces and the transparency options, or in the default component color wireframe mode.

7. Use the between surf function to re-create the 3 midsurfaces previously deleted.
   - From to the midsurface panel select the create sub-panel.
   - Select the between surf option.
   - For side 1 select one surface from the lvl0 component that defines the first side of the given section.
   - For side 2 select the surface on the opposite side of the section.

![Image](image2.png)

- Verify that the combine with adjacent plates check box is selected, and that the toggle is set to new comp.
- Click extract.
- Repeat these steps for the other 2 midsurfaces to re-generate.

**Hint** Start with the larger 2 square midsurfaces and finish with the narrow rectangular midsurface.
Notes: The *combine with adjacent plates* options combines the new midsurface with the closest midsurface, while the *combine all adjacent plates* option combines the new midsurface with all neighboring midsurfaces.

When you do not obtain the right midsurface with the given combination of these options, it is often useful to compare the results of using one, the other, none, or both of these options.

Notice how the midsurfaces that were re-generated now are correctly shaped and correctly positioned. There are still some problems with the midsurfaces that we have not yet worked on, and we will address these in the next section using a different approach.

The midsurface that was missing from the beginning still needs to be created. We are saving its creation until after most of the neighboring midsurfaces are corrected.

8. Use the *between surfs* function with the same options to generate the midsurface that was missing all along.

In this section we used the *between surfs* function to not only create midsurfaces that were missing, but also to re-generate new midsurfaces where inaccurate ones were initially produced. This is one way of correcting potential problems that are produced when midsurfaces for entire parts are generated. Another approach is presented in the next section.
Step 4: Correct midsurfaces by editing them.

1. Re-creating surfaces by hand is one possible approach to resolving problems with incorrectly shaped and/or positioned surfaces. This can be time consuming as it involves deleting surfaces first, before re-creating new ones. One alternative is to edit the existing midsurfaces to correct these problems directly. One of the editing functions available on the midsurface panel's edit sub-panel is the quick edit function. This function consists of re-defining some of the handles that define the midsurface's offset distance and direction, allowing for an immediate update in shape and position, thus correcting this class of problems.

Use the quick edit function to fix the last two midsurfaces that are incorrectly shaped and/or positioned.

This function uses various color codes to identify the original midsurface, the original surface (source) for it, as well as an updated midsurface. It is therefore important to work in the default component color mode (0) when using this function so that the various surfaces can be easily recognized.

2. Click the Wireframe Geometry icon.
3. From the midsurface panel select the edit sub-panel.
4. Select the quick edit function.
5. Click help.

This brings up the on-line help for the midsurface panel. Follow the link to the edit sub-panel help and review the help for the quick edit function. This contains all the definitions needed to understand and effectively use this function.
6. Use the **edge to edge** type to repair first the smaller square surface.
   - Set the **target type**: to **edge to edge**.
   - Set the **target location**: to **mid point**.

   We will update the definition of this midsurface using the edges of the two surfaces defining this section of the part. For each edge of the midsurface we update, HyperMesh will line it up with the mid point edge from the two edges we select as reference.

   - With the **surf** selector active, select the square midsurface.

   Several new entities appear in different colors. In orange is the midsurface you selected. In cyan is the midsurface (in-progress) that you can edit by re-assigning the targets in red. In yellow is the surface to offset (the original surface from which the middle surface was created).

![Image of midsurface repair process](image)

**Quick edit entities and color code**

The **edge** selector, located under **edge to offset**, is active and ready for you to select one edge from the original surface (yellow) to match with the corresponding edge from the opposite surface as **pilot edge**. The combination will define the mid point edge for the midsurface to edit.

- Select one edge from the original surface (yellow).
- With the edge selector under **pilot edge** active, select the corresponding edge on the opposite surface defining this section.
Repeat these last two steps for the remaining pairs of edges until all (red) targets are updated.

Alternatively, you can use the arrow buttons to the left of edge to offset to cycle through all the edges of the original surface and simply select a pilot edge for each one of them. The active edge to offset is identified with a red circle.

- Click update to accept the new midsurface.

7. Use the point to point type to repair the larger side surface.
   - Set the target type: to point to point.
   - Set the target location: to as selected.

In this mode, the midsurface to edit uses the fixed point selected by the user. We select this mode to simply take advantage of the fact that all the other midsurfaces are correct and therefore offer a set of fixed points that are correctly located. We will simply force the fixed points of the last midsurface to edit to these locations as needed.

Note We could have used the edge to edge type just as easily here, and vice versa for the other surface we already fixed. Both methods are equivalent.
- Click `surf` to make it the active selector and select the last midsurface to update.

The same temporary entities as earlier are displayed. Observe carefully each corner of the midsurface to edit (cyan) and see how it fits with the neighboring midsurfaces’ corners. You may zoom into one of the corners and use the arrow buttons to cycle through all of them.

After careful observation, you should identify some corners that require updating, a possible two of which are show in the image below with the pilot points to use to re-define them.

- Under point to offset select the point selector.
- Select one of the points to offset as needed and as described in the figure above.
- Select the corresponding pilot point.
- Repeat these last two steps for all the remaining pairs of points (corners) requiring an update.
- Click update to accept these changes.

**Note** In most cases, several parts are present in a given model, and this can make it difficult to identify which surface, edge or point to select. In such cases, use the *Spherical Clippling* panel from the permanent menu. This panel allows you to focus on a specific area of a model by showing only the model inside of a sphere and masking everything outside. Review the help for this panel for more detailed information.

8. Use the *Display panel* to turn off the display of the geometry in the * lvl* component.
9. Use the *Shaded Geometry and Surface Edges* icon to observe the midsurfaces.

The free (red) edges remaining inside the boundaries of the set of midsurfaces are an indication that some edge equivalencing is required.

The *midsurface* panel's *edit* sub-panel has the *replace edge* function that can be used to equivalence free edges.

10. Restore *view5*.

   The gap observed here could be closed by updating the definition of the midsurface we are directly facing in this view using the same approach as we did in this section. In this case, it is simply easier to close that gap by snapping the two free edges together.

11. Use the *replace edge* function to close the gap.

   - From the *midsurface* panel select the *edit* sub-panel.
   - Select the *replace edge* function.
   - Under *retained edge*: select the *line* selector.
   - Select the lower edge (see figure below).
   - Select the upper free edge as the *edge to move*.
   - Click *cleanup tol* = and enter 0.5.

This tolerance represents how far apart the free edges can be to be equivalenced.

   - Click *replace*.

This closes the gap and turns the free (red) edges into a shared (green) edge.
12. Use the edge edit panel to equivalence any remaining free edges.
   - From the Geom page, select the edge edit panel.
   - Select the equivalence function.
   - Click surfs and select displayed from the pop-up dialog.
     You can leave all other selections unchanged.
   - Click equivalence.
     This turns the last free edges into shared edges. We now have a complete set of midsurfaces.

This concludes this tutorial. You may discard this model, or save it to your working directory for your own reference.

In this tutorial, we experimented with both midsurface creation tools available in HyperMesh. We also used some of the editing tools to fix incorrectly shaped and/or positioned midsurfaces. Other editing tools are also available in the edit sub-panel, and although we did not use them here, they are powerful tools in correcting other types of midsurfaces issues. The midsurfaces that were created here can be meshed, defeatured, edited, exported, etc., just like any other surface in HyperMesh.
Simplifying Geometry - HM-2020

In this tutorial, you will learn:

- Mesh the clip, review the mesh quality, and determine the features to be simplified
- Remove surface fillets
- Remove edge fillets
- Remove pinholes

This exercise involves changing the shape of a part in order to simplify the geometry. Certain details of the shape, such as small holes or blends, may simply not be necessary for the analysis being performed. When these details are removed, the analysis can run more efficiently. Additionally, mesh quality is often improved as well. Changing the geometry to match the desired shape can also allow a mesh to be created more quickly.

Tools

The **defeature** panel can be accessed by:

- On the **Geometry** menu, click **Defeature**
- From the **Geom** page, go to the **defeature** sub-panel

The **defeature** panel allows you to find and delete pinholes, fillets on surfaces and surface edges, and duplicate surfaces.

The **automesh** panel can be accessed by:

- Press F12
- On the **Mesh** menu, click **AutoMesh**

The automesh panel allows you to create meshes or re-mesh existing meshing interactively or automatically on surfaces or groups of elements. You can use the sub-panels to provide specific meshing parameters.
The **check elems** panel can be accessed by:

- Press F10
- On the **Mesh** menu, click **Check Elements**

The **check elems** panel allows you to verify the basic quality of the elements.

The **check elems** panel can be accessed by:

- Press F10
- On the **Mesh** menu, click **Check Elements**

The **check elems** panel allows you to verify the basic quality of the elements.

<table>
<thead>
<tr>
<th>Check Elements 2D</th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1-d online</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2-d</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3-d</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>time</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>user</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>group</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>warp g</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>length</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>aspect</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>jacobian</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>shear</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>repair</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>check dev std</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>min angle</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>max angle</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>comp</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>include</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>connectivity</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>duplicates</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>settings</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>paa listed</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>standard</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Exercise:**

This exercise uses the model file, **clip_defeature.hm**. The model file has geometry that has been midsurfaced. (Surfaces have been created on the mid-plane of the part.) The model will be meshed using an element size of 2.5. You can assume a simple structural analysis will be run on the part, and thus does not require much detail. Based on this, there are features, which are not necessary and can be removed.

**Step 1: Retrieve and view the model file.**

The model for this exercise is **clip_defeature.hm**.
Step 2: To easily work with the midsurface, turn off the display of the lvl0 component.

If the lvl0 component is displayed, it needs to be turned off so that you can easily work on the midsurface geometry. (It may be on if you used the model you had open for the previous section.)

1. Press D on your keyboard to go to the Display panel.
2. On the right-hand side of the screen, set the collector type selector to comps if it is not already set.
3. On the right-hand side of the screen, set the entity type selector to geoms.
4. If it is checked, right-click the check box for the lvl0 component to turn off the display of the geometry in that component.
5. Click return.

Step 3 (Optional): Mesh the clip to view mesh quality before defeaturing.

1. Click the Shaded Geometry and Surface Edges icon.
2. Go to the automesh panel.
3. Set the selector type to surfs.
4. Go to the size and bias sub-panel.
5. In the element size = field, type 2.5.
6. For mesh type, select mixed.
7. Switch the meshing mode from interactive to automatic.
8. Verify that the elems to surf comp toggle is set.
9. Select surfs >> displayed to select all displayed surfaces.
10. Click mesh to generate the mesh preview.

11. Click return to go to the main menu.
Step 4 (Optional): Review the quality of the mesh.

Take a minute to look over the mesh that was created. Note the areas that have irregular, poor quality mesh. Also, use the check elems panel to evaluate the minimum length check of the elements.

Take a minute to rotate, zoom, and pan the model to review the mesh that was created. Note the locations where the mesh was not created in neat rows and columns of quads.

1. Go to the check elems panel.
2. Go to the 2-d sub-panel.
3. In the length field, type 1.
4. Click length to evaluate the minimum length.

Many of the elements failing the length test are located around the fillets of this model.

**Note:** You may need to change the geometry display to wireframe for better visualization of element quality.

5. Click return.
6. Press D to turn off the display of the elements in the lvl0 component.
Step 5: Remove the four small pinholes.

Pinholes are closed free edge loops within a surface. Pinholes do not need to be circular.

1. Go to the **defeature** panel.
2. Go to the **pinholes** sub-panel.
3. In the **diameter** field, type **3.0**.
4. Select surfs >> all.
5. Click **find** to identify the pinholes having a diameter of 3 or less.

Notice the $xP$ symbol at the center of the four circular holes. These symbols are highlighted in white, indicating they are pinholes identified by HyperMesh for removal.

6. Click **delete** to remove the selected pinholes in the model.

The selected pinholes are removed and replaced by fixed points located at the center of the original pinholes.
Step 6: Remove all surface fillets in the clip.

1. Go to the defeature panel.
2. Go to the surf fillets sub-panel.
3. If the surfaces are not shaded, click the Shaded Geometry and Surface Edges icon.
4. For find fillets in selected, select surfs.
5. Select surfs >> displayed.
6. In the min radius field, type 2.0.
7. Click find to identify all the surface fillets with radius of 2 or greater.

Surface fillets identified for removal

8. Click remove.
Step 7: Automatically identify and remove rounded corners of surfaces.

You should still be in the **defeature** panel.

1. Go to the **edge fillets** sub-panel.
2. Select **surf s >> displayed**.
3. In the **min radius** field, type **1.0**.
4. Set the bottom switch to **all** to find **all** the fillets.
5. Click **find**.

The edge fillets that meet the filter criteria are identified on the screen with an **F** symbol and radial lines marking the fillet beginning and end.

6. Notice how the selector moves down to the **fillets** entity selector.
7. Right-click on one of the **F** fillet markers on the screen to deselect the fillet.
8. Click **remove** to delete the selected edge fillets.

All the fillets are removed.
Step 8: Mesh the defeatured geometry and view quality.

1. Go to the automesh panel.
2. Select surfs>>displayed.
3. Click mesh.
   
   Observe the mesh and you will notice that the mesh is created in rows of quads.

Step 9 (Optional): Save your work.

Now that the model has been simplified, it is a good time to save the model.

Summary

The model is now represented in a much simpler form that suits the analysis that will be performed. Holes, surface fillets, and edge fillets were removed that were considered too small to be captured by the desired element size of 2.5.
Refining Topology to Achieve a Quality Mesh - HM-2030

In this tutorial, you will learn how to:

- Mesh the part to determine poor element quality
- Suppress small edges
- Split surfaces
- Remove interior fixed points
- Replace closely placed fixed points
- Create final mesh

Topological details of the geometry may affect the quality of the mesh created from the surfaces. Some of these details may not reflect any major feature of the part's shape, and can be removed without concern. When modifying the topology affects the shape of the surfaces, a compromise must be made between the part shape and the element quality necessary for the analysis. Other times, adding topological features that do not change the shape of the part may actually help create a better quality mesh.

Tools

The automesh feature can be accessed by:

- Pressing F12 on the keyboard
- On the Mesh menu, click AutoMesh

The automesh panel allows you to create meshes or re-mesh existing meshing interactively or automatically on surfaces or groups of elements.

Tools

The check elems feature can be accessed by:

- Pressing F10 on the keyboard
- On the Checks menu, click Check Elements

The check elems panels allow you to verify the basic quality of the elements created.

Tools

The quick edit feature can be accessed by:

- Press F11
- On the Geometry, click Quick Edit
This panel combines many tools for rapid editing of model geometry.

The **surface edit** feature can be accessed by:

- Press Shift + F9
- On the **Geometry**, point to **Edit**, click **Surface**

The surface edit panel allows you to perform a variety of surface editing, trimming, and creation functions. This panel also allows you to offset surfaces in their normal direction.

**Strategy**

The following strategy is best practice for using the topology refinement feature.

<table>
<thead>
<tr>
<th>Box</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Use the <strong>elements check</strong> sub-panel to find areas of poor element quality</td>
</tr>
<tr>
<td>2</td>
<td>Use the <strong>edges</strong> sub-panel</td>
</tr>
<tr>
<td>3</td>
<td>Sometimes suppressing all edges and then unsuppressing desired edges can be a good method</td>
</tr>
<tr>
<td>4</td>
<td>Experience is a key factor for mastering topology refinement, so continue to experiment</td>
</tr>
</tbody>
</table>

**Exercise: Refining Topology to Achieve a Quality Mesh**

**Step 1: Open the model file.**

The model for this exercise is `clip_refine.hm`. Take a few moments to observe the model using the different visual options available in HyperMesh (rotation, zooming, etc.).
Step 2: Create a preliminary mesh.

1. Go to the automesh panel.
2. Set the selector type to surfs.
3. Go to the size and bias sub-panel.
4. In the element size field, type 2.5.
5. For mesh type, select mixed.
6. Switch the meshing mode from interactive to automatic.
7. Click surfs, and click displayed.
8. Click mesh.
Step 3: Review the mesh quality.

1. Take a minute to rotate, zoom, and pan the model to review the mesh that was created. Note the locations where the mesh was not created in rows and columns of quads.
2. Go to the **Check Elements** panel.
3. Go to the **2-d** sub-panel.
4. In the **length** field, type 1.
5. Click the **length** button to evaluate the minimum length.
6. Note the elements that failed the check. The topology will be edited to correct of some of these, and the others will be left as is.
7. Go to the main menu.
8. Press the D key and turn off the display of the elements in the lvl10 component.

Step 4: Remove short edges by combining fixed points.

1. Go to the **quick edit** panel.
2. For replaced points, click moved.
3. Select the lower fixed point as indicated in the image below. Once the point is selected, the **retain** button becomes active.
4. Select the upper fixed point as indicated in the image below. Once the second point is selected, the two points are merged together.

Selecting fixed points to be combined
Step 5: Remove the fixed points interior to all surfaces.

1. For remove point, click point.
2. Select the four fixed points as shown below.

   Each fixed point will be deleted as you select it.

   These fixed points are left over from a defeaturing operation where small holes were removed. They could remain without greatly sacrificing the element quality, given the element size used for the mesh.

   ![Fixed points to be removed](image)

3. Click return to go to the main menu.

Step 6: Add edges to the surfaces to control the mesh pattern.

1. For split surf, click node (see image below for which node button to click).
2. Zoom into the area indicated below and select the indicated fixed point.

3. With the active selector now on lines, select the line shown in the image below.
   Once both the point and line are selected, an edge will be created from the location of the fixed point perpendicular to the line.

Select fixed point and line to split the surface.
4. Repeat #2 and #3 for the following point and line.

Select fixed point and line to split the surface.

Select this point.

Select this line.
5. Repeat #2 and #3 for the following point and line.

Select fixed point and line to split the surface.

6. Repeat #2 and #3 for the following point and line.

Select fixed point and line to split the surface.
Step 7: Add edges to the surfaces to control the mesh pattern.

1. Go to the *surface edit* panel.
2. Go to the *trim with surfs/planes* sub-panel.
3. In the *with plane* column, click the *surfs* entity selector.
4. Select the surfaces indicated in the image below.

![Surfaces to be selected for splitting](image)

5. If necessary, toggle the direction selector to *N1*, *N2*, and *N3*. Click *N1* to make it active.
6. Press and hold your left mouse button, and then move it over the edge indicated in the figure below.

   ![Cursor change](image)

   Once over the line, the cursor will change to a square with a dot in the center. Release your mouse button. Click two points anywhere along the edge. Do not click a third.

   Nodes will be placed on the line for *N1* and *N2*.
7. Press F4 on the keyboard to enter the distance panel.
8. Go to the **three nodes** sub-panel.

9. As in step #5, press and hold your left mouse button, and then move it over the edge of the hole, as indicated in the following image. Once over the line, the cursor will change to a square with a dot in the center. Release your mouse button.

10. Click three points anywhere along the edge.

   Temporary nodes will be placed on the line representing \( N1, N2 \) and \( N3 \). Note that the technique used to create nodes to select where none existed before can be used in any place where nodes need to be selected but don’t exist in the model. You can create nodes in this manner on lines, surfaces and elements. For more details, see the HyperMesh online help. Pick the index and type in, Picking Nodes on Geometry or Elements.

11. Click **circle center** to create a node at the center of the hole.

12. Click **return** to go to the **surface edit** panel.

13. Click **B** to make it the active selector.

14. Select the node that was just created at the center of the hole.

15. Click **trim**.

16. Click **return** to go to the main menu.

   The surfaces are trimmed through the center of the hole.
Step 8: Suppress shared edges causing a small edge.

1. Go to the quick edit panel.
2. For toggle edgle: click line to make it active.
3. Select each of the lines in the image below using your left mouse button.
   Each line will become suppressed (blue) as you select it.

Step 9: Remesh the part.

Remesh the surfaces of the part, using the automatic mode, a size of 2.5, and the mixed mesh type.

1. Press D and turn select the lvl10 check box to turn on the elements.
2. Go to the automesh panel.
3. Verify that elem size = is set to 2.5 and the mesh type is set to mixed.
4. Select surfs >> displayed to select all displayed surfaces.
5. Click mesh.
Step 10: Review the mesh quality.

1. Take a minute to rotate, zoom, and pan the model to review the mesh that was created. Note that the mesh now consists completely of rows and columns of quads.

2. Go to the Check Elements panel.

3. In the length field, type 1.

4. Go to the 2-d sub-panel.

5. Click the length button to evaluate the minimum length.
   
   Note the elements that failed the check. There are only two elements, and these fail the check because of the shape of the part. However, they are not too small compared to the global element size, so you can leave them as is.

6. Go to the automesh panel.

7. Go to the Ql optimize sub-panel.

8. Verify that elem size = is set to 2.5 and the mesh type is set to mixed.

9. Click edit criteria.

10. In the Target element size field, type 2.500.

11. Click Apply and OK.

12. Select surfs >> displayed to select all displayed surfaces.

13. Click mesh.

14. If you get a message saying, "There is a conflict between the user requested element size and quality criteria ideal element size", click the button Recompute quality criteria using size of 2.5.

15. On the Checks menu, click Quality Index.

16. Go to pg1 and verify that the comp. QI is 0.01.

Step 11 (Optional): Save your work.

The part is now meshed and ready to be set up for an analysis. Save the model, if desired.
Creating and Editing Line Data - HM-2040

In this tutorial, you will learn how to:

- Create a circle, arc, line, and tangent lines
- Duplicate and translate lines
- Edit lines by splitting and displaying its ID
- Delete redundant arcs and lines
- Duplicate and reflect an arc
- Create a surface square and two parallel lines on an X-Y plane
- Create fillet between two lines

Sometimes CAE users need to create models from sketches where there is no pre-existing geometry. The tools in this tutorial will help you accomplish that task.

Tools

The circles panel can be accessed in the following ways:

- On the Geometry menu, point to Lines, and click Circles
- On the Geom page, go to circles

The circles panel allows you to create circles and arcs by entering the center and radius, points and a vector, or three points. It also allows you to find the center point of a circle or an arc.

The lines panel can be accessed in the following ways:

- On the Geometry menu, point to Lines, and click Create
- On the Geom page, go to lines

The lines panel allows you to create new line data from models, elements, or existing geometry.

The planes panel can be accessed by:

- On the Mesh menu, point to 2-D, point to Primitives, and click Planes
- On the 2D page, go to planes
The *planes* panel allows you to create a square, planar surface, and/or mesh in a user-specified plane or a surface and/or mesh bounded by planar lines.

### Exercise: Creating and Editing Line Data

This exercise teaches you how to create lines and surfaces.

**Step 1: Create a component collector to geometry.**

1. Access the **collectors: create** sub-panel in one of the following ways:
   - On the **toolbar**, click on the collectors icon.
   - On the **Organize** menu, click **Collectors**.
2. Select **components** as the entity type.
3. For **name = type geometry**.
4. Use the switch to toggle from **card image = to no card image**.
5. Click **color** and chose **yellow**.
6. Click **create**.
7. Click **return**.

**Step 2: Create nodes.**

1. On the **View** menu, point to **Standard Views** and click **Isometric**.
2. Go to the **create nodes** panel.
   - On the **Mesh** menu, point to **Nodes** and click **Create Nodes**.
   - On the **Geom** page, go to **nodes**.
3. Go to the **type in** sub-panel.
4. To create the nodes, enter the X, Y, and Z coordinates in the table below and click **create node** for each of the nodes.

<table>
<thead>
<tr>
<th>Node</th>
<th>X</th>
<th>Y</th>
<th>Z</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>0</td>
<td>0</td>
<td>25</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>37</td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>5</td>
<td>25</td>
</tr>
<tr>
<td>5</td>
<td>0</td>
<td>5</td>
<td>-2</td>
</tr>
</tbody>
</table>
5. Click **return**.
Step 3: Display the node IDs.

1. Access the numbers panel in one of the following ways:
   - On the Checks menu, click Numbers
   - On the Tool page, go to numbers
2. Change the entity type to nodes.
3. Click nodes and on the extended entity selection menu click all.
4. Click on to display all the node IDs.
5. Click return.

Step 4: Create a circle.

1. Go to the circles panel.
2. Go to the center & radius sub-panel.
3. With the active selector set to node list, pick node 2 from the graphics area.
   This will be the location of the circle’s center.
4. Switch the orientation vector to the X-axis
5. With the active selector set to base point, pick node 2 from the graphics area.
   In this case, the base point defines the position of the plane on which the circle is going to be created.
6. Toggle to circle
7. For radius, specify 5.
8. Click create.
9. Remain in the Circles: Center and Radius sub-panel.

Step 5: Create an arc.

1. Toggle from circle to arc.
2. With the active selector set to node list, pick node 2 from the graphics area.
   This is going to be the center of the arc.
3. Ensure that the orientation vector is set to X-axis.
4. Pick the node with ID number 2 again as the base for the axis of rotation.
5. For angle = specify 180.
6. For radius = specify 2.5.
7. For offset = specify 90.
8. Click create to create an arc.
9. Click return to exit the circles panel.

10. On the View menu, point to Standard Views, and click Rear.

Step 6: Create a line.

1. Go to the lines panel.
2. Go to the from nodes sub-panel.
3. Pick the nodes with ID number 4 and node 5 in node list.
4. Click create to create a line between nodes 4 and 5.
5. Click return.
Step 7: Duplicate and translate lines.

1. Access the translate panel in one of the following ways:
   - On the Tools menu click Translate.
   - On the Tool page, go to translate.
2. Change the entity type to lines.
3. Pick the line that was created between nodes 4 and 5.
4. Click lines again to display the extended entity selection menu.
5. Click duplicate.
6. Click current comp to copy the new line into the current component (Geometry).
7. Click the plane and vector collector switch and select y-axis
8. Click magnitude = and enter 10.0.
9. Click translate -. 
10. Press the P key to refresh the screen.
11. Click return.
Step 8: Edit lines by splitting at a line.
1. Access the line edit panel in one of the following ways:
   - On the Geometry menu point to Lines and click Edit/Combine.
   - On the Geom page, go to line edit.
2. Go to the split at line sub-panel.
3. Click lines and pick the circle.
4. Click cut line and pick the line between node 4 and node 5.
5. Click split.
6. Repeat this procedure on the other line that was just translated.
7. Click return.

Step 9: Display the line IDs.
1. Go to the numbers panel.
2. Change the entity type to lines.
3. Click lines to display the extended entity selection menu.
4. Click all.
5. Click on to display all the line IDs.
6. Click return.

Step 10: Delete a redundant arc.
1. Go to the delete panel.
   - From the Edit menu click Delete.
   - On the Tool page, go to delete.
2. Change the entity type to lines.
3. Select the lower semi-circle (line id 10) from the graphics area.
4. Click on delete entity to delete the redundant arc.
5. Click return.

Step 11: Duplicate and reflect an arc.
1. Access the reflect panel in one of the following ways:
   - On the Tools menu click Reflect.
   - On the Tool page, go to reflect.
2. Change the entity type to lines.
3. Choose the arc (line id 2) from the graphics area.
4. Click the plane and vector collector switch and select z-axis.
5. Pick node 2 as the base node.
6. Click **lines** again to display the extended entity selection menu.

7. Click **duplicate**.

8. Click original comp to copy the new line into the current component (Geometry).

   *original comp* allows you to place all duplicated entities into the component collector where duplication occurred. *current comp* allows you to place all duplicated entities into the current working component defined in the **header bar**.

9. Click **reflect** to create the lower arc.

10. Click **return**.

11. Click **p** on your keyboard to refresh your graphics display.

![Diagram of geometry operations](image)

**Step 12: Create two tangent lines.**

1. Go to the **lines** panel, and **tangents** sub-panel.

2. Select the node with ID number **3** as the **node list**.

3. Select the **line** panel.

4. Select the semi-circular line with ID number **7**. Note: Line ID may be different.

5. Click **find tangent**

   There are two tangent lines on screen.

6. Click **return** to exit the **tangent** panel.

7. Pick one of the tangents.
8. Repeat steps 4-5.
9. Select the other tangent.
10. Click \texttt{return} to exit the \texttt{tangent} panel.

\textbf{Step 13: Redisplay the line IDs.}
1. Go to the \texttt{numbers} panel.
2. Click the input collector switch and select \texttt{lines}.
3. Click \texttt{lines} to display the extended entity selection menu.
4. Click \texttt{all}.
5. Click \texttt{on} to display all the line IDs.
6. Click \texttt{return} to exit the \texttt{numbers} panel.

\textbf{Step 14: Split curves by tangent line, and delete redundant line.}
1. Go to the \texttt{line edit: split at line} sub-panel.
2. Pick semi-circular line 7 for lines and tangent line 12 for cut line.
   \textbf{Note:} Line ID may be different.
3. Click \texttt{split} to split line 7 by line 12.
4. Repeat steps 3-5 in order to cut curved line 8 by tangent line 13 in \texttt{line edit} panel.
5. Press the F2 key to jump into \texttt{delete} panel from \texttt{line edit} panel.
6. Select the curved lines between tangent lines 12 and 13.
7. Click \texttt{delete entity} to delete the curves.
8. Click \texttt{return} twice to go back to main menu.
Step 15: Create a component collector for surfaces.
1. Go to the collectors: create sub-panel.
2. Click name = and enter surfaces.
3. Click the switch under creation method and select no card image.
4. Click color and select purple.
5. Click create.
6. Click return to exit the collectors panel.

Step 16: Create a surface square on an X-Y plane.
1. Go to the planes: square sub-panel.
2. Click the input collector switch and select z-axis.
3. For base node, choose the node with ID number 1 to be the base reference node.
4. Choose surface only from the triangle entity switch.
5. Enter 30 in the size = input field.
6. Click on create to create a square surface.
7. Click return to exit the planes panel.

Step 17: Create a line which connects two parallel lines on an X-Y plane.
1. Go to the lines panel.
2. Go to the at intersection sub-panel.
3. Select z-axis (located at the bottom of the panel) to represent the intersection plane.
   The reason we choose the z-axis is because we want to create the line on the X-Y plane.
4. For base, choose the node with ID number 1 to be the base node.
5. Use the lines with plane option.
6. For line list, choose the two straight lines that are perpendicular to the X-Y plane.
   A bold line displayed on the screen represents the result.
7. Click intersect to create the line.

Step 18: Switch the current working component surfaces to geometry.
1. Click Comps on the tool bar to access and change the current component.
2. Verify that the field next to comp reads surfaces.
3. Click comp, and change it to geometry from the collector name list.
   From this point onwards any element or geometry created, will be placed in the geometry component collector.
Step 19: Extend line to surface edge.

1. Click the User Views icon.
2. Click on Iso1.
3. Go to the line edit panel.
4. Go to the extend line sub-panel.
5. Toggle from distance = to to:.
6. Change the entity type from node to line.
7. Choose line created in step 18 as the line to be extended (the upper line panel).
8. Choose the line shown in the figure below as the to: line.
   Now you see a red V marking the beginning of the line to be extended.
9. Click on extend +.
   You can see the line is extended to reach one surface edge.
10. Click return to exit the line edit panel.
   The result should resemble the figure below.
Step 20: Create a fillet between two lines.

1. Access the line: fillets sub-panel in one of the following ways:
   - On the Geometry menu click Lines.
   - On the Geom page, go to lines.
2. Go to the fillets sub-panel.
   You will use the create option.
3. Check trim original lines.
4. For radius=, enter 5.
5. For 1st line, pick line 3 (see the following figure).
6. For 2nd line, pick the purple straight line which is perpendicular to line 3.
   Please select fillet quadrant is displayed in the message bar. HyperMesh is asking you to select a reference location for fillet.
7. Pick the x above X-Y plane and closest to node 1.
   You can see a fillet on screen created by HyperMesh.
8. Click *return* to exit the *Lines* panel.

Step 21: Trim a line by plane and delete a redundant line segment.
1. Go to the line edit panel.
2. Go to the split at plane sub-panel.
3. Select line 4 in the lines panel.
4. Choose z-axis from the input collector switch.
5. Choose node 1 as the base node.
6. Click split to split line 2 by the X-Y plane.
7. Press the F2 key to jump into the delete panel.
8. Switch the entity type to lines.
9. Choose the small line segment under the X-Y plane, and click on delete entity to remove the line segment.
10. Click return twice to return to the main menu.

Step 22: Remove all temp nodes.
1. Access the temp nodes panel in one of the following ways:
   • On the Mesh menu point to Nodes and click Temp Nodes
   • On the Geom page, go to temp nodes
2. Click clear all to remove all temp nodes.
3. Click return to return to the main menu.

Step 23: Change to performance graphics.
1. Click the Shaded Geometry icon on the toolbar.
Step 24: Export all geometry as an IGES file.

1. On the Files menu point to Export and click IGES Geometry.
2. Input a File name: and
3. Save your file.

The IGES file you have generate can be shared with other CAD packages such as UG, Catia, and ProE.
Creating Surfaces from Elements - HM-2050

In this tutorial, you will learn how to:

- Generate surfaces from existing elements
- Plot elements
- Control what surfaces are created

The surfaces created in this process are regular surfaces that can be used for geometry editing (for changes to a design) and meshing, and to export geometry information (in reverse engineering applications, for example). This is particularly useful if you are trying to obtain geometry information (surfaces) from a model containing elements only.

Tools

The surface creation from FE can be accessed by:

- On the Geometry menu, point to Surfaces, and click Create. Go to from FE sub-panel.
- On the Geom page, go to surfaces panel, then go to from FE sub-panel

The features feature can be accessed by:

- On the Checks menu, click Features
- On the Tools page, go to the features sub-panel

The features panel calculates features (corners) in the current model and displays them by creating one-dimensional plot elements or feature lines. It provides a visualization tool, allowing you to see the edges of a complex model where the normals of adjacent elements differ by more than the user-specified feature angle. If your mesh contains adjoining elements with normals pointing in opposite directions, features are created between those elements (even if their true feature angle is less than specified).
Exercise:

This exercise uses the model file, fe_to_surf.hm. The model is the tetrahedral mesh of a bracket. It is organized into a single component, and does not contain any entities besides the solid elements.

Step 1: Open the model and create shell elements.

1. From the files panel, select the hm file sub-panel to retrieve the file <install_directory>/tutorials/hm/fe_to_surf.hm.

   The model is loaded in wireframe mode. Shade the elements to review the shape of the bracket. This solid mesh was obtained by running the HyperMesh tetramesher on a tria mesh of the surfaces defining the initial part.

   In this tutorial, you will reverse this process by obtaining the shell elements and then the surfaces. You can then, for example, re-mesh the surfaces with a different element size, or export them as an IGES file.

2. Use the faces panel to generate shell elements on the outside of the solid mesh.
   - From the Tool page, select the faces panel.
   - With the entity selector set to comps, click any element.

      The element is temporarily highlighted, signifying that the component has been selected. The tolerance field can be left unchanged, as it does not influence the creation of face elements.

      Click find faces.

      HyperMesh creates shell elements on the free faces of the solid elements (faces that are not shared with any other element), and places them into the ^faces component collector.
3. On the toolbar, click the **Display** icon to go to the **Display** panel and turn off the display of the elements in the **tetras** component.

![Faces (shell) elements](image)

**Step 2: Obtain surfaces from elements.**

Use the **surfaces** panel and **from FE** sub-panel on the tria (faces) elements to obtain surfaces and understand the behavior of the panel. Start by creating a component collector for the new surfaces using the collectors panel.

1. On the toolbar, click the **collectors** icon to go to the **collectors** panel and create a component collector with the name **surfaces**. Select any color, and do not assign any card image or material to the component.

2. Run the **FE surf** functionality on elements in the **^faces** component as shown in the image below.

![Select 2 elements for selection by face](image)
- From the **Geom** page, click **surfaces**, and select the **from FE** sub-panel.
- With the upper **elems** selector active, select **displayed**.
- Toggle to **auto defect features** and **mesh based auto tolerance**.
  
  Auto detect features will automatically create 1d plot elements at feature lines. Features are created where the normals of adjacent elements vary more than the feature angle specified in the options panel. Once the feature lines are created, it also combines open ended features to form closed loops. These features are used as delineations for the new surfaces being created.

  Mesh based autotolerance option allows the tool to determine the tolerance as a factor of the average element size. The new surfaces created are allowed to deviate from the existing mesh no more than the specified/calculated tolerance value.

- Set **surface complexity**: to 5 using the slider bar.
- Click **create**. It takes a few seconds (30-40) to create surfaces.

3. Turn off the display of all elements to review the surfaces that were created.

Notice how only two surfaces (over 70) were created. Take some time to review the surface by rotating and zooming in and out the model. The delineation of the surfaces may or may not correspond to what a specific user may expect or wish to obtain. For example, you may want to have three separate surfaces in some areas of the model and fewer surfaces in other areas.

On the toolbar, click the **User Views** icon to restore previously saved views 1 thru 5 where delineation lines are not intended.

4. Delete the surfaces that were generated by going to the **Tool** page and selecting the **delete** panel.

5. Turn on the display of the elements in the **^faces** component.

In this section, you have learned how to use the FE surf panel to generate some surfaces that can later be meshed.

You have also seen that when the surface generation engine is asked to create surface delineation automatically; the surfaces obtained may not necessarily have the specific delineation one may wish to obtain.

In order to obtain specific delineation, plot elements can be used to define the boundaries of the various surfaces, and can be supplied to the engine.

**Step 3: Capture features with plot elements.**

Delineating the surfaces to be created is an essential step in obtaining the desired surfaces. This level of control is achieved by supplying the surface generator with some plot elements, which will indicate what the boundaries of the various surfaces should be. This function works well only when the selected plot elements form closed loops.

The new surfaces should definitely have boundaries that respect the features of the tria mesh as the tria mesh captured, to some extent, the features of the initial geometry.

Generate plot elements that correspond to the features of the mesh. You can use the edges, features, and edit element panels to create plot elements. Using the features panel is one of the most automated ways of generating plot elements, although it does not always create the features as desired. Some manual methods will be used to modify the results of automatic feature creation.
1. Use the **features** panel to automatically generate plot elements capturing the features of the tria mesh (**faces** component). Use a break angle of 30 degrees.

   - From the surfaces panel, from FE subpanel, click on features button to take you to the **features** panel. This is a shortcut to this panel. You can also find features panel in the Tool page by selecting the **features** sub-panel.
   - Set the entity selector to **elems**
   - Click **elems** and select **displayed**.
   - Enter 30 in the **feature angle** field.
   - Select the **advanced analysis** check box.
     This option performs further analysis on the features created based on the angle and combines and extends them to create closed loops.
   - Click **features**

Plot elements representing features

This generates plot elements representing the features of the mesh (see image above). These plots elements are automatically created in a component collector named **^feature**. For detailed information, view additional details on the feature panel.

On the toolbar, click the **user views** icon to restore previously saved views 1 thru 5 where the features are not as intended by the user.
2. Click view to restore view1.

Notice how too many plot elements are created to define the boundary in that area. We will try to remove some to reduce the clutter.
3. From the **features** panel, select the **edit** sub-panel.
   - Click on **elem** for the **element features to remove** and pick the plot elements as shown in the image below. As you pick on these plot elements, the entire row of elements to the next intersection is selected.
   - Click **remove**.

4. Now we will add a new delineation feature.
   - Remain in the features panel, edit sub-panel.
   - Click on the **nodelist** for **nodes to add features**.
   - Click on the **nodelist** and choose **by path**.
   - Select the nodes as shown in image below.
   - All the nodes in the path between these two nodes are selected.
- Click *add.*
  A new feature line is created.

5. Click the *user views* icon to restore view 2.

Notice that the features created here are of zigzag pattern. We will delete those and create new smooth features

- From the features panel, select the edit sub-panel.
- Click on *elem* for the *element features to remove* and pick the plot elements as shown in the image below. As you pick on these plot elements, the entire row of elements to the next intersection are selected.
- Click *remove*.

Features to be removed

6. Follow procedure in above step 4 and add two new feature lines (see image below).

New features added
7. Repeat the above cleanup operations to create features to the users needs. The image below shows an example of the final features. Notice that too many features in the cylindrical holes have been removed.

Model with corrected features

You created plot elements that will be used in the surfaces panel to indicate the boundaries of the surfaces to generate. These plot elements were generated in an attempt to capture the features of the tria mesh. Obviously, the number and location of plot elements generated using this approach is directly dependent on the value that is chosen for the feature angle.

In most situations, a lower feature angle will generate more plot elements while a higher one will yield fewer plot elements.

It is often useful to experiment with different values for the feature angle as one value may bring you much closer to the desired set of plot elements than another, limiting significantly the amount of subsequent editing required.

In this section, you learned how to create and edit plot elements using the features panel. The creation process was straightforward, but required some editing in order to obtain a set of plot elements forming closed loops only. Various tools are available to make the editing process as easy as possible and we used the ones that would allow us to get to our goal the most effectively.

Now that both the shell elements and the plot elements delineating the surfaces are available, let us generate surfaces on the entire model.
8. Use the **global** panel to set the current component to surfaces.

9. Generate the surfaces using the **surfaces** panel, from **FE** subpanel.
   - Click the upper most elems selector, and select by collector from the extended entity selection dialog.
   - Select the ^faces component and click select to return to the panel.
   - Click the toggle next to **auto detect features** to be set to **feature edges** selector
   - Click on **feature edges** selector, and select by collector.
   - Select the ^feature component and click select.
   - Leave all other options unchanged.
   - Click **create**.

10. Turn off the display of all elements to review the surfaces that were generated (see image below).

   ![Surfaces generated](image)

   The surfaces generated could now be exported or used for any surface editing or meshing operation.

   This concludes this tutorial. You may discard this model or save it to your working directory for your own reference.

   As this tutorial showed, this is a powerful tool in generating surface data where none is available, but needed. It also provides you with a great deal of control over the surfaces that are generated through the use of plot elements. Automated and semi-automated ways let you create and edit plot elements quickly and easily.
Creating and Editing Solid Geometry - HM-2060

In this tutorial, you will learn:

- What is solid geometry
- What is topology
- What does 3D topology look like

Solids are geometric entities that define a three-dimensional volume. Geometric entities are defined as follows:

- Point: 0 dimensional; has only x, y, and z coordinates
- Line: 1-dimensional; has length, can be curved through 3-dimensional space
- Surface: 2-dimensional; has an area
- Solid: 3-dimensional, has a volume

The use of solid geometry is helpful when dividing a part into multiple volumes. For example, divide a part into simple, mappable regions to hex mesh the part.

Tools

The **solids** feature can be accessed in one of the following ways:

- On the **Geometry** menu, point to **Solids**, and click **Create**
- On the **Geom** page, and go to **solids**

The solids panel allows you to new solid entities from existing geometry such as lines and surfaces.

![](image1)

The **primitives** feature can be accessed in one of the following ways:

- On the **Geometry** menu, point to **Surfaces**, and click **Primitives**
- On the **Geom** page, and go to **primitives**

The **primitives** panel contains tools for the relatively quick creation of surfaces in basic shapes, such as squares, cylinders, cones, spheres, and tori.

![](image2)

The **surfaces** feature can be accessed in one of the following ways:

- On the **Geometry** menu, point to **Surfaces**, and click **Create**
- On the **Geom** page, and go to **surfaces**
The **surfaces** panel is used to create new surfaces using a variety of techniques.

![Surfaces Panel](image1)

The **solid edit** feature can be accessed in one of the following ways:

- On the **Geometry** menu, point to **Edit**, and click **Solid**
- On the **Geom** page, and go to **solid edit**

The **solid edit** panel presents several tools for modifying solid entities, including trimming and/or splitting solids, and merging solids into a single entity.

![Solid Edit Panel](image2)

**Exercise: Creating and editing solid geometry**

This exercise uses the model file, `solid_geom.hm`.

![3D Model](image3)

**Step 1: Retrieve model file, solid_geom.hm**

Access the **Files** panel in one of the following ways:

- On the **File** menu, select **Open**
- On the toolbar, click the **files** icon

---

Altair Engineering

HyperMesh 8.0 Tutorial - Geometry  71

Proprietary Information of Altair Engineering
Step 2: Create solid geometry from the bounding surfaces.
1. On the Geom page, enter the solids panel.
2. Verify that you are in the bounding surfs sub-panel.
3. Verify that the preview solid option is checked.
4. Select one surface on the part.
5. All of the surfaces should automatically be selected.
6. Create the solid.
7. The message bar indicates that a solid has been created. The solids are identified by thicker lines than surfaces.
8. Return to the main menu.

Step 3: Create a solid geometry cylinder using primitives.
1. Go to the primitives panel.
2. Go to the cylinder/cone sub-panel.
3. Toggle full cone to full cylinder.
4. Click bottom center, and select one of the temporary nodes (see image below).
5. The cursor automatically advances to the normal vector button.
6. Select the remaining temporary node shown in the image.
7. For base radius= enter 1.5.
8. For height= field enter 25.
9. Click create solid.
   A solid cylinder is created in the middle of the first solid that was created.
10. Return to the main menu.
Step 4: Subtract the cylinder’s volume from the rest of the part.

1. Enter the **solid edit** panel.
2. Go to the **boolean** sub-panel.
3. Verify that operation type: is set to simple (combine all).
5. With the solids entity select for A: active, select the original solid.
   
   The cursor advances to solids next to B:.
6. Select the solid cylinder created in step 3.
7. Click **calculate**.

8. To confirm the material has been removed, click the shaded icon, 🎨, and rotate the model to inspect the part.
Step 5: Split the solid geometry using bounding lines.
You should still be in the solid edit panel.

1. Go to the trim with lines sub-panel.
2. Under with bounding lines:, activate the solids entity selector, and click anywhere on the model to select it.
3. Activate the lines entity selector and select the lines shown in the image below.

4. Trim the model.
   A plane was trimmed and indicates that two solids now intersect.
Step 6: Split the solid geometry using a cut line.

You should still be in the solid edit panel, trim with lines sub-panel.

1. Under with cut line; activate the solids entity selector, and select the small, tetrahedral shaped solid created in step 5.

2. On the toolbar, go to the User Views icon.
3. From the pop-up window, click restore1.
4. Click drag a cut line.
5. Pick two locations on screen such that they define the endpoints of a line that roughly divides the tetrahedral solid in half, as shown below.
6. Click the middle-mouse button to split the solid.
7. Select the half of the original tetrahedral solid as shown below.

8. Use *with cut line:* to split the solid as shown below.
9. Select the solid shown in the image below.

10. Click the *User Views* icon and click *restore2*.

11. Use *with cut line*: to split the solid as shown below.
Step 7: Merge solids together.
You should still be in the solid edit panel.

1. Go to the **merge** sub-panel.
2. With the solids entity selector under to be merged: active, select the three solids shown below.

   Select these solids

3. **Merge** the solids.

   The resulting solids in the tetrahedral area should look like the image below. There should be two solid entities, with one of them being hexahedral in shape in the corner.
Step 8: Split the solid geometry with a user-defined plane.

You should still be in the solid edit panel.

1. Go to the trim with plane/surf sub-panel.

2. Click the User Views icon and click restore3.

3. With the solids entity selector under with plane: active, select the large solid representing the majority of the part.

4. Set the plane selector to N1N2N3.

5. Press and hold the left mouse button, and move the mouse cursor over one of the two edges shown below.

The edge should highlight.
6. Release the mouse button, and left-click in the middle of the edge. A green temp node appears at the location to indicate the selection for N1. The plane selector is advanced to the N2 selection.

7. In the same manner, highlight the other line shown in the image and select two nodes along its length.

Your selection should look similar to the image below.

8. **Trim** the solid.
Step 9: Split the solid geometry with a swept line.
You should still be in the solid edit panel.

1. Go to the trim with lines sub-panel.
2. With the solids entity selector under with sweep lines: active, select the solid with the cylinder removed.
3. Activate the line list entity selector and select the edges used in step 8 to define $N_1$, $N_2$, and $N_3$.
4. Under sweep to: set the plane selector to x-axis
5. Verify the the panel is set to sweep all below the plane selector.
6. Trim the solid.

Step 10: Split the solid geometry with a principal plane.
You should still be in the solid edit panel.

1. Go to the trim with plane/surf sub-panel.
2. With the solids entity selector under with plane: active, select the solid with the cylinder removed.
3. Switch the plane selector from $N_1N_2N_3$ to z-axis
4. Press and hold the left mouse button, and move the mouse cursor over the edge shown below. The edge should highlight.

5. Release the mouse button, and left-click anywhere along the edge.

6. A purple temp node appears at the location to indicate the selection for the base node.

7. Trim the solid.

8. Return to the main menu.

Step 11: Split the solid geometry by creating surfaces inside the solids.

1. Enter the **surfaces** panel.

2. Go to the **spline/filler** sub-panel.

3. Deactivate the **auto create(free edge only)** and **keep tangency** options.

4. Select the five lines shown in the image below.

5. **Create** the surface.
6. Go to **Geom > Solid edit > trim with plane/surf > with Surfs** select the solid and surface, and click **trim**.

7. Select the four lines shown in the image below from within the **Geom > Surfaces > spline/filler** panel.

![Diagram showing four lines to be trimmed.](image)

8. Go to **Geom > Solid edit > trim with plane/surf > with Surfs** select the solid and surface, and click **trim**.

9. **Create** the surface.

10. **Return** to the main menu.

**Step 12: Suppress extraneous edges on the part.**

Enter the **edge edit** panel.

1. Go to the **(un)suppress** sub-panel.
2. Select **lines >> by geoms**
3. With the solids entity selector active, select the four solids shown in the image below.

![Diagram showing four solids to be suppressed.](image)

4. Click **add to selection**.
5. Set **breakangle** to 45.
6. **Suppress** the edges.
7. **Return** to the main menu.